
# $ K + Welcome
Intelligent Maintenance, together with Intelligent Incident and Intelligent Parking, are
companion products to Intelligent Control and make up the Intelligent Control suite of
programs.

Intelligent Maintenance requires that Intelligent Control is installed and functional.

# $ @ + File
The File menu consists of the following options:

• AutoStartAutostart>Second
• Log OnLog_On>Second
• Log OffLog_Off>Second
• Change PasswordChange_Password>Second
• TimeoutTimeout>Second
• Extended LoggingExtended_Logging>Second
• Large Toolbar IconsLarge_Toolbar_Icons>Second
• Exit

# $ @ + Autostart
If the instance of Intelligent Maintenance that is running on a client computer running
a video wall in a Traffic Management Center, you can start that instance of Intelligent
Maintenance automatically, without having a user log in. In this case, the AutoStart
option will have a check next to it in the File Menu list and when Intelligent
Maintenance is started, the current map will automatically be displayed.

# $ @ + Log On
Use the Log On screen to enter a User and Password to access the Intelligent
Maintenance software.

User is the name used to log on to the system. The name that is entered can be up to 10
characters in length and can consist of alpha and/or numeric characters. Note that the
name is case sensitive.

The Password is unique to a User. It can be up to 10 characters in length and can
consist of alpha and/or numeric characters. The password is case sensitive. Please
make a note of the Password for each User.

Press enter or click on the OK button when the required information has been entered.
If a valid User and Password is entered, the Log On window will close and the Main
Menu will be enabled. If an invalid User or Password is entered, a message will be
displayed advising you of the fact and allowing you to rectify and continue.

Only one User can be logged on at any one time. To log on as a different User, first log
off as the current User and then log on again using another User name.



# $ @ + Log Off
Use the Log Off option to log off from the system. This function will not close the
software. To close the software, select the Exit option.

If there is no activity for a specified period of time (as specified using the Timeout
option on the File menu), a Log Off Warning window will appear, warning that the
user will be logged off.

To remain logged on, click on the ‘Stay Logged On’ before the time indicated has
elapsed.

# $ @ + Change Password
Use this utility to change passwords. The User is displayed for reference purposes. To
change the Password, first enter the Old Password. If your entry for Old password is
invalid, a message will be displayed advising you of the error. Correct the Old
Password and then enter the new Password in both the Password field and the Confirm
field. Click the Change button to update the User record with the new Password. If the
same Password is entered in both fields (Password and Confirm), a message will be
displayed advising that the password change was successful. The new Password will
be effective immediately. Make a note of the new Password.

If the same Password is not entered in the Password and Confirm field, a message
advising that the Passwords do not match will be displayed. The Change Password
form will open again. Re-enter the same Password information into both fields and
click the Change button to update the User record with the new Password.

Click on Close to close the form.

# $ @ + Timeout
Enter the number of minutes of inactivity that should pass before the timeout warning
window is displayed. The value entered here can be between 5 and 60 minutes. Note
that the default is 10 minutes and this value will automatically be entered when this
option is selected from the File menu.

When the specified period of inactivity is reached, a warning will be displayed,
allowing the User to choose to stay logged on.

Click on the Stay Logged On button within the time allowed to remain Logged On
under the current User. If you do not click the Stay Logged On button you will be
logged off the system.



# $ @ + Extended Logging
Extended Logging controls the amount and type of detail that is included in the log
files. For standard operation, extended logging should not be turned on. It should only
be turned on if additional detail is required in the log file for diagnostic purposes.

If Extended Logging is not selected, when the menu option is clicked, a window will
open.Click the Yes button if extended logging should be activated or click No to leave
extended logging inactive.

If Extended Logging is already selected, when the menu option is clicked, a window
will open. Click the Yes button to turn extended Logging off or click No to leave
Extended Logging active.

# $ @ + Large Toolbar Icons
All of the functions that can be accessed using the Menus in Intelligent Maintenance
have associated Icons that are displayed on the left hand side of the screen. These
Icons can be displayed in two sizes – normal and large. To have large icons displayed,
select Large Toolbar Icons from the File menu. As soon as you do this, the Icons
displayed will change to the larger size. To change from large toolbar icons to normal
size, select Large Toolbar Icons from the File menu and the icons will immediately
revert to the normal size.

A check mark next to Large Toolbar Icons in the File menu indicates that the large
icons are selected.

# $ @ + Maintenance
This is where all the reported Maintenance can be viewed and are managed. When a
maintenance event is reported, the operator will enter the details of the event here, by
clicking the Manual tab and selecting and/or entering the correct options.

The Maintenance Screen consists of several tabs. These tabs are used to group the
maintenance events into categories so that they can be more logically viewed and
managed.

Manual This is where maintenance events are
manually entered.

Unconfirmed This is a list of the maintenance events
that have been reported but not yet
confirmed

Pending
This is a list of maintenance events that
have been reported or scheduled but are
in a pending status.

Confirmed
This is a lit of all the maintenance events
that have been reported or scheduled and
have been confirmed.



Expired
This is a list of maintenance events that
have expired (their duration has passed)
and they have not been cleared or closed.

Cleared
This is a list of maintenance events that
have been cleared but cannot be closed
yet as some further action is required.

Closed This is a list of all the maintenance
events that have been closed.

The Manual tab is different from all the others in that this is where the maintenance
events are reported. All the other tabs have identical content.

Category Indicates the broad category into which
the maintenance falls. Examples would
be repairs, unscheduled, routine
maintenance etc. If the category that you
wish to use does not display in the drop
down list, you will have to add a new
category as described in the
Administration section of this User
Guide.

Type Further defines the maintenance in terms
of its category. For example, in the
repairs category you could have types
like minor, major, emergency etc. If the
type that you wish to use does not
display in the drop down list, you will
have to add a new type as described in
the Administration section of this User
Guide.

Source

This indicates how the maintenance was
ent
ere
d:

Manual It was called in, emailed
in, or was viewed on
camera and reported.

Automatic The maintenance is
scheduled – a routine
expected event.

Detection This maintenance was
determined by detection
devices.

Central Schedule This maintenance
was generated by the
Central Schedule in
Intelligent Control.

Description
This is a brief description of the
maintenance. It will display on the
Maintenance lists and in all reports so it
should be as meaningful as possible.



should be as meaningful as possible.

Resource Engineer
Select the responsible resource for this
event from the drop down list. Resources
are added in the Administration,
Configure section.

Expected Duration
This indicates – either in days or hours,
the length of time that it is anticipated
that the maintenance will be active. This
information is informational only.

Comment This is a mandatory field and must be
entered. It will be displayed in the log of
the maintenance events and should
contain further details of the
maintenance event.

Map View

Select the map on which the
maintenance event is to be displayed.
Only the maps that have been created in
Intelligent Control will be available for
selection.

Impact
Indicate the impact that the maintenance
is having on traffic. The available
options are Low, Medium, High and
Emergency.

Location Point Select the location point for this
maintenance event.

Standard Operating Procedure If a standard operating procedure is to be
attached to this maintenance event, select
the procedure from the drop down list
box. If no standard operating procedure
exists, click on New to create one for
this event.

Once all this information has been entered, click on the Save Maintenance button. The
Maintenance will be added to the database as an “unconfirmed” maintenance event, and
will appear in the Unconfirmed Tab list.

Once the Maintenance event is in the Unconfirmed Tab list, it will be reviewed by a
supervisor or manager, who would then update its status accordingly.

Maintenance Due to Expire

The Maintenance Due to Expire button will flash when any maintenance (on any tab) is
due to expire. This is in order to draw the operator’s attention to the expiring
maintenance so that the information can be checked and updated if necessary. If a
maintenance event is allowed to expire, it will be moved to the Expired tab.

Expired, Cleared and Closed Maintenance Tabs

In addition to the information that is included on the other tabs, these tabs have a section



that allows you to further define which maintenance events you want to include in your
list when you view it.

Filter Maintenance

These are the parameters that can be chosen to narrow down the list that is displayed if
necessary. You can chose to filter the maintenance list using any of the following:

Date You can select only the maintenance
events that fell within the last 30 days, or
you can enter a specific date range.

Category You can select only a specific category
of maintenance for display.

Type You can select only a specific type of
maintenance within the category.

Impact You can select maintenance events based
on their impact.

Resources You can select maintenance events based
on the allocated resource

Once you have made your selections, click on the filter button and only the maintenance
events that meet the parameters that you have entered will be included in the displayed
list.

# $ @ + GIS Map View of Maintenance
This is a pictorial view of all confirmed maintenance events that have been reported.
To view the Job Card for a particular event, double click on the Icon that depicts the
event.
The map view can be manipulated using the buttons on the top task bar.

Map Views You can select another map for viewing
by clicking on the Map Views drop
down list and highlighting the map that
you wish to access.

Filter Use the drop down list to display all the
items available for display. Put a check
in the box adjacent to this items that
should display on the selected map. If an
item is not checked, it will not display on
the map.

Zoom in and Zoom out

When you Zoom In on a map, the detail
level of the map itself will increase, as
will the level of detail on the Icons for
the Devices. To zoom in to an area, click
the Zoom In button and then, holding the
left hand mouse button down “draw” a
box around the area that you want to
look at, and release the mouse button.
The Map and the Device icons will be
repositioned and resized, still correctly
reflecting the correct geographical
position of the Devices.



The Map and the Device icons will be
repositioned and resized, still correctly
reflecting the correct geographical
position of the Devices.

To Zoom Out to get a wider view of the
map area, click on the Zoom Out button
and then click the left hand mouse button
anywhere on the map. The Map will
Zoom Out one level (the actual details
levels are set by the administrator) with
each click on the mouse. The Device
Icons will be repositioned and resized
with each level.

Pan

To pan to another area of a map, click on
the Pan Icon. The cursor will change to
look like a hand. Position the cursor on
the Map, and holding down the left hand
moose button, move the map until east,
west, north or south. The map will
relocate, and the Devices will remain
located in the actual geographical
positions. Note that while you are
actually moving the map, parts of the
screen will appear blank, As soon as you
release the mouse map, the entire screen
will be redrawn with the new view area
displayed.

Full Extent
To get back to the original map and
display, click on the Full Extent button.
This will revert the map to its original
saved zoom level and icon display.

Close Click here to close the map view.

Use these options to zoom in for more detail on the map, or zoom out for less.
Use this option to move the map up, down, left or right.
Use this option to select items for display on the map
Click here to choose the map you want to view.
Click here to return the map view to its full extent
Click here to close the map.

# $ @ + Refresh Maintenance
This utility is used to refresh the database and the map view. Use it only if
maintenance events are not appearing correctly in the Maintenance section or on the
GIS Map View.

When you chose this option, the following warning will be displayed, advsing you tjat
all other activity must be temporarily halted in order to refresh maintenance. Click yes
to proceed and the database will be updated.



# $ @ + Run
This utility allows you to run other executable programs from within Intelligent
Maintenance.

# $ @ + Configure Maintenance
The Configure section is where you configure some of the features in Intelligent
Maintenance to accommodate your unique requirements.

o Category ManagementCategory_Management
o Device ManagementDevice_Management
o Device ModelsDevice_Models
o Location ManagementLocation_Management
o Resource ManagementResource_Management

# $ @ + Category Management
If you should find that a particular maintenance event that you are adding to the
maintenance screen does not exist, this is where you would add the Category to cover
that event.

When you select the Maintenance Category option a window opens, allowing you to
add a new Maintenance Category, change some details of an existing category or
delete a particular category.

Adding a New Maintenance category

To add a new maintenance category, click on the drop down list box and select “Add a
New category”. The description field will be blank, allowing you to enter the
description for the new category.

3. The Save button will be highlighted. Click on it and Save the new category to the
database.
1. Click on the drop down list box and select Add a New category.
2. Enter the description of the category.
Maintenance Category is a drop down list that will display all the available
maintenance categories. Additionally, it will display “Add a New category” which is
the selection you should make to add a new maintenance category.

Description is a free format text field that describes the maintenance category. Make
this name of the category as meaningful as possible so that any operator will
understand the nature of the maintenance when it is displayed in Intelligent
Maintenance.

Once you have entered the new maintenance category description, Click on the Save
button to add the category to the database. Then click on the Associated Icon tab to
select the icon that should be used when this maintenance category is reported
elsewhere in Intelligent Maintenance.



3. Click on the Link To Icon to associate this icon with this category.
2. Click on the drop down list and select the required icon.
1. The newly entered category will be displayed here.

Either select an icon from the drop down list or select Add Icon to add a new icon.

If you select Add a new Icon, enter the Name for the new Icon and then browse to that
icon by clicking on the Browse button. When you have selected the correct icon, click
on Save, and that Icon will now be included in the drop down list above.

Now you can select the required icon. Highlight that Icon in the drop down list box and
click on Link To Icon. That icon will now be used to depict that category when it is
displayed in Intelligent Maintenance.

Now that you have associated an Icon for the category, you will be able to define the
“types” of occurrence for that category. For example, the repair category can have
several types - scheduled, emergency, routine etc.

Click on the Maintenance Types tab, and a new window will open. All the
Maintenance Types that have been entered already will be displayed in the
Maintenance Types window. You will be able to select the ones from this list that are
applicable for the new category that you have created. Double click on the
Maintenance Type and it will be displayed in the Category Maintenance Types
window. If a type does not exist, you can add a new type by clicking on the “New”
button, and entering the new type in the Edit field. Then click on Save to add that new
type to the list.

Click Close to exit the Maintenance Category configuration utility.

# $ @ + Device Management

This utility allows you to view all the devices that are currently listed in Intelligent
Maintenance.

The devices that are part of the Intelligent Control System can be added to the list by
accessing the Intelligent Control database. Devices that are outside the spectrum of
Intelligent Control can be added manually.

To edit information for a device that is already in the list, highlight that Device and
click on Edit Device.

To add a new Device, click on the Add Device button and the Maintenance Device
Model window will open.



# $ @ + Device Models

This is the screen which allows you to enter details for the devices that are managed by
Intelligent Maintenance.

You can access this screen by double clicking on a device in the Device Summary
Utility which is located in the Configure section of the Administration Menu, or you
can select it by choosing Device Models from the Configure section of the
Administration menu.

Maintenance Device

Select the Device from the drop down list. This is also where you indicate of the
device is a system configured device (configured in Intelligent Control) or if it is
Maintenance Device that is entered into Intelligent Maintenance for maintenance
purposes.

Device Location Point
Chose the desired location point.

Maintenance Device Name
This indicates the name of the selected Device as it will appear in the maintenance
lists.

Device Model
Select the applicable device model from the drop down list.

Model name
The model name will display here.

Make
The device make will display here.

Manufacturer
The name of the manufacturer of the device will be displayed here.

Device Model Referenced Documents

Full details of any documents that are needed in the maintenance of the device will be
listed here.



# $ @ + Location Management

Select Location Management from the Administration, Configure Maintenance menu.
The following screen will be displayed:

Select the required map view from the Map Views drop down list.

Click on the New Location button and the cursor will change to a “Bullseye”. Drag the
cursor to the required location on the map and right click the mouse. The icon will be
displayed as a square with a T in it, indicating that it is a temporary location.

To make the location permanent, right click on the “T’ Square a new window will
open. Enter a description for this Maintenance location and click on the Save button.
The icon will be changed to a blue square, indicating that it is permanent.

Click Close to close the Maintenance Location utility

# $ @ + Resource Management

This is where you would edit or add the resources that are available to you as part of
the maintenance system. When you add a new maintenance Event, you are required to
allocate a Resource Engineer to the event. This is where you enter the information for
the resources.

To add a new resource, click on Add a new Resource in the droop down list attached to
Resource.

Select the Resource Type from the drop down list. If the applicable resource type is not
in that list, click on Add a New resource Type and enter that Resource Type in the
field below.

Then enter the Contact Name and contact details as laid out in the screen.

Click Save to add the resource to the drop down list.

# $ @ + Operators
This is where you define which Operators have access to which information. Operators
can only be added, deleted or chnaged in Intelligent Control. The Intelligent
Maintenace Functions to which they have access are defined here.



# $ @ + Access Levels
Various access levels for each of the users that have access to the system can be set.
The functions that a particular user can access are set based upon the Access Level that
is allocated for each user.

Each user is allocated an access level when their details are added to the system. Up to
3 levels are provided for – Operations, Maintenance and Administration.

Every form in the system has controls on it. You can specify which controls should be
accessible by which level of user.

To do this, click on the Forms drop down list box and highlight the form for which
access levels are to be set.

Each control that is available on the form will be listed in the Control Name list.

The Description field provides a brief description of the function of the control.

Each level can have one of three types of access allocated – read write, read only or
not accessible. Read write allows the operator full access to the field or control
function, read only allows limited access (can only view the field or control function)
and not accessible renders that field or control completely inaccessible to that level of
operator.

To edit the access levels for a particular control or field, highlight that control or field
in the list and its details will be displayed in the edit fields below the data window.
Select the applicable access requirement for each Level and click on the Apply button.

Note about Menu Items: You can set the access levels for menu items in a similar
manner to setting access levels on forms. The setting of access to menu items is done
by selecting MDI from the “Forms” drop down list box. The menu items will be
displayed and you can set the access levels for each level of user. Note that read-write
will provide full access to the menu, read only will grey the menu item so that it can be
viewed but is not actionable, while not accessible will cause the menu item to
‘disappear’ completely and the operator will not even know of its existence.

# $ @ + Profiles
The Profile function serves two main purposes. The first is to ensure that each and
every form and control in Intelligent Maintenance is included in the database so that
Access Levels can be correctly set for them. The second is to allow you to create and
save different profiles. This feature would be used if you wanted to experiment with
empowering users by giving them more authority. If you save the current profile
before making those changes, you can easily revert to it if and when you decide that
the experiment was unsuccessful. Alternatively, if you request Intelligent Devices, Inc
to create a specific set of Access Levels, that set of Access Levels can be sent to you as
a Saved profile and can be applied to your database by selecting it and making it the
current profile.



Save Current profile As……….

Each level of user in Intelligent Maintenance can be assigned differing levels of access
to each and every aspect of Intelligent Maintenance, as described in the Access Level
section above. This allows the look and feel and authority for each level to be
customized for your installation. Once you have set the Access Levels, you can save
that group of settings into a Profile for future use. To do this, click on the Save Current
Profile As… button. A window will open requesting you to enter a name for the
profile:

Name the profile in such a way that you can easily recognize the authority levels that it
represents. Click on OK to save the Profile.

Select Profile and make Current
This function is used to change the current profile. If you have set Access Levels that
are not working to your satisfaction, you can revert to a previously saved profile. This
allows you to easily recover from experiments that go wrong. Also, you would use this
option to install a profile that is acquired from another source, for example if you had
Intelligent Devices, Inc create a customized profile for you.

To select a particular profile, highlight the name of the profile in the profiles list and
click on the Select profile and Make Current button. A window will open asking you to
verify that you are sure that this is the action you wish to take:

Click OK to use the selected profile.

Verify Profile
This option will scan though Intelligent Maintenance and make sure that the Access
Level form contains all the forms and controls in Intelligent Maintenance so that the
Access Level settings are correct.

Delete Profile
This option allows you to delete an unused Profile. Highlight the Profile that is no
longer required and click the Delete Profile button. A window will open asking you to
verify your action:

Click OK to delete the selected Profile or Cancel to retain the Profile.

# $ @ + Help
The Help menu accesses the help file and provides details about the version of
Intelligent Maintenance that is running.

# $ @ + Search
This will open the help file, enabling the utility to search for help on a specific topic.



# $ @ + About Intelligent Maintenance
Clicking on About Intelligent Maintenance will open a window that will detail the
current version that is installed.

The System Info button will display a window, providing a summary of system details.
This may be required for diagnostic purposes.

# $ @ + Operations
The Operations menu consists of the following options:

• MaintenanceMaintenance>Second
• GIS Map View of MaintenanceGIS_Map_View_of_Maintenance>Second
• Refresh MaintenanceRefresh_Maintenance>Second
• Run…Run>Second

# $ @ + Administration
The Administration Menu consists of the following options:

• Configure MaintenanceConfigure_Maintenance>Second
o Category ManagementCategory_Management>Second
o Device ManagementDevice_Management>Second
o Device ModelsDevice_Models>Second
o Location ManagementLocation_Management>Second
o Resource ManagementResource_Management>Second
• OperatorsOperators>Second
o Access LevelsAccess_Levels>Second
o ProfilesProfiles>Second

# $ @ + Job Card
The Job Card contains all the information that is displayed on the Maintenance Tab. In
addition, it also contains Maintenance Current Status, which is where the current status
of the maintenance event can be changed.

Unconfirmed The maintenance event is still not
confirmed and must remain on the
unconfirmed list.

Pending The maintenance event is confirmed but
certain details are still pending. It will be
moved to the pending tab list.

Confirmed
The maintenance event is confirmed and
will be moved to the Confirmed tab list.
It will also be displayed on the GIS Map
View of Maintenance screen.

Duplicate
The maintenance event has already been
reported and should be removed as a
duplicate. This maintenance event will
be removed from the unconfirmed tab.

Expired The maintenance event has expired – its
duration has passed- but it has not yet
been cleared or closed on the system.
The maintenance event will be
transferred to the Expired tab.



duration has passed- but it has not yet
been cleared or closed on the system.
The maintenance event will be
transferred to the Expired tab.

Cleared
The maintenance event has been cleared
and is no longer a problem, but some
action is still required. The maintenance
event will be moved to the Cleared tab.

Closed
The maintenance event is closed – no
further action remains. The maintenance
event will be moved to the Closed tab.

Remove The maintenance event is invalid and
must be removed from the database. This
maintenance event will not appear on
any of the tabs.

Once you have selected the appropriate status, the Maintenance Event Progress will
automatically be updated. Click on Save to update the maintenance event and it will
automatically be moved to the correct tab.

If at any time you wish to view a log of the progress of the maintenance event, double
click on that event to open the Job Card, and then click on the Show Progress button.

Click on Close to close the Job card without making any changes.


